
Refresh Statistics

Refreshes the statistical display in WINS Manager.



Status Bar

Toggles display of the status bar at the bottom of the WINS Manager window.



Delete WINS Server

Removes the selected WINS server from the list in the WINS Manager window.



Split

Allows you to size the panes in the WINS Manager window by dragging and then clicking to indicate the pane 
size.



Exit

Exits WINS Manager.



Clear Statistics

Resets all statistical counters.



Introduction to Using WINS Servers

A WINS server is a Windows NT Server computer running Microsoft TCP/IP and the Windows Internet Name 
Service (WINS) server software. WINS servers maintain a database that maps computer names to TCP/IP 
addresses, allowing users to easily communicate with other computers while gaining all the benefits of TCP/IP.
A computer running the WINS server should be assigned a fixed IP address. The WINS server computer should 
not be a DHCP client. If the WINS server computer has more than one network adapter card, make sure the 
binding order of IP addresses is not changed.

Notes
You must be logged on as a member of the Administrator's group to install or run the WINS Manager tool. 

To use or configure a WINS server, you must have full administrative rights for that server. 
Using WINS servers can offer these benefits on your internetwork:
Dynamic database maintenance to support computer name registration and name resolution. Although 

WINS provides dynamic name services, it offers a NetBIOS namespace, making it much more flexible than DNS for 
name resolution. 

Centralized management of the computer name database and the database replication policies, alleviating
the need for managing LMHOSTS files.

Dramatic reduction of IP broadcast traffic in LAN Manager internetworks, while allowing client computers to
easily locate remote systems across local or wide area networks.

The ability for clients running Windows NT and Windows for Workgroups on a Windows NT Server network 
to browse domains on the far side of a router without a local domain controller being present on the other side of 
the router.

An extremely scaleable design, making it a good choice for name resolution for medium to very large 
internetworks.



Starting and Stopping the WINS Service

The WINS service is a Windows NT service running on a Windows NT server. The supporting WINS client software 
is automatically installed for Windows NT Server and for Windows NT computers when the basic operating 
system is installed.

To start and stop the WINS service

1 In Control Panel, double-click the Services icon.
2 In the Service list, click Windows Internet Name Service, click Start, Stop, Pause, or Continue.

Note
You can also start and stop the WINS Server service at the command prompt using the commands net 

start wins, net stop wins, net pause wins and net continue wins. When paused, WINS will not accept name 
packets from clients. This enables a WINS administrator to prevent clients from using WINS while continuing to 
administer, replicate, and scavenge old records.



Administering WINS Servers

When you install a WINS server, the WINS Manager icon is added in Program Manager. You can use this tool to 
view and change parameters for any WINS server on the internetwork. 
You must be logged on as a member of the Administrators group for a WINS server to configure that server. 

To start WINS Manager
Click Start, point to Programs, then to Administrative Tools (Common), and then click WINS 

Manager.
Or, at the command prompt, type start winsadmn. You can include a WINS server name or IP address with 
the command (for example, start winsadmn 11.103.41.1 or start winsadmn myserver).

Notes
If the Windows Internet Name Service is running on the local computer, that WINS server is opened 

automatically for administration. If the Windows Internet Name Service is not running when you start WINS, the 
Add WINS Server dialog box appears.

The WINS Manager window appears when you start WINS Manager. The title bar in the WINS Manager 
window shows the IP address or computer name for the currently selected server, depending on whether you used 
the address or name to connect to the server. WINS Manager also shows some basic statistics for the selected 
server. To display additional statistics, on the Server menu, click Detailed Information.

See Also

Connecting to a WINS Server
Statistics in WINS Manager
Displaying Information in WINS Manager



Connecting to a WINS Server

You must be logged on as a member of the Administrators group for a WINS server to configure the WINS server 
you are connecting to. Only one administrator can administer a particular WINS server at any moment. 
If you specify an IP address when connecting to a WINS server, the connection is made using TCP/IP. If you 
specify a computer name, the connection is made over NetBIOS.

To connect to a WINS server for administration

1 If you want to connect to a server that you have previously connected to, under WINS Servers, double-click 
the appropriate server icon.
Or, if you want to connect to a server that you have not previously connected to, on the Server menu, click 
Add WINS Server.

2 In the WINS Server box, type the IP address or computer name of the WINS server you want to work with, 
and then click OK.
You do not have to include double backslashes before the name. WINS Manager will add these for you.

Note
The following icons, which appear in the WINS Manager window, show whether the server is a push partner

or pull partner when replicating the database:
    Both push partner and pull partner
    Pull partner
    Push partner

    WINS server that is not a replication partner

See Also

Configuring WINS Servers



Statistics in WINS Manager

The WINS Manager window displays statistics for the activities on the selected WINS server.
Server Statistics
Last Replication Times
Total Queries Received
Total Releases
Total Registrations

See Also

Displaying Information in WINS Manager
Configuring WINS Servers



Server Statistics

The Server Start Time is the date and hour when this WINS server was started. Database Initialized shows 
the most recent time when static mappings were imported from an external file into the database. Statistics 
Cleared shows the time when statistics for this WINS server were last cleared.



Last Replication Times

Periodic shows the last time the WINS database was replicated based on the replication interval specified in the
Preferences dialog box. Admin Trigger shows the last time the WINS database was replicated when the 
administrator clicked the Replicate Now button in the Replication Partners dialog box. Net Update shows 
the last time the WINS database was replicated as a result of a network request, which is a notification message 
from a replication partner that has requested database change updates.



Total Queries Received

The number of name query request messages received by this WINS server:
Successful indicates how many names were successfully matched in the database.
Failed indicates how many names this WINS server could not resolve.



Total Releases

The number of messages received that indicate a NetBIOS application has shut itself down:
Successful indicates how many names were successfully released.
Failed indicates how many names this WINS server could not release.



Total Registrations

The number of messages received that indicate name registrations on clients.



Displaying Information in WINS Manager

To refresh the statistical display in WINS Manager
On the View menu, click Refresh Statistics.

Or, from the Options menu, click Preferences, and under Server Statistics, click Auto Refresh, and, 
optionally, type a value for Interval (Seconds). The default value is 60 seconds.

To reset the statistical display in WINS Manager
On the View menu, click Clear Statistics.

To see information about the current WINS server
On the Server menu, click Detailed Information.

The Detailed Information dialog box shows basic information about the connection, including the server 
status and the administrative rights of the currently logged on user:
WINS Server Address
Last Scavenging Times
Unique Registrations
Group Registrations
For descriptions of the related intervals, see Configuring WINS Servers. 



Configuring WINS Servers

You will want to configure multiple WINS servers to increase the availability and balance the load among servers.
Each WINS server must be configured with at least one other WINS server as its replication partner. 
For each WINS server, you must configure threshold intervals for triggering database replication, based on a 
specific time, a time period, or a certain number of new records. If you designate a specific time for replication, 
the replication occurs only once. If a time period is specified, replication repeats at that interval.

To configure a WINS server

1 On the Server menu, click Configuration.
This command is available only if you are logged on as a member of the Administrators group for the WINS 
server you want to configure.

2 For the WINS Server Configuration options, specify time intervals by typing a time or clicking the spin 
buttons, as described in the list below.
Renewal Interval
Extinction Interval
Extinction Timeout
Verify Interval

3 If you want this WINS server to pull replicas of new WINS database entries from its partners when the system 
is initialized or when a replication-related parameter changes, click Initial Replication in the Pull 
Parameters options, and then type a value for Retry Count.

4 To inform partners of the database status when the system is initialized, click Initial Replication in the Push 
Parameters group.

5 To inform partners of the database status when an address changes in a mapping record, click Replicate On 
Address Change.

6 Set any Advanced WINS Server Configuration options, as described below under Advanced WINS Server 
Configuration Options.

Notes
The replication interval for this WINS server's pull partner is defined in the Preferences dialog box. The 

extinction interval, extinction timeout, and verify interval are derived from the renewal interval and the replication 
interval specified. The WINS server adjusts the values specified by the administrator to keep the inconsistency 
between a WINS server and its partners as small as possible. 

The retry count is the number of times the server should attempt to connect (in case of failure) with a 
partner for pulling replicas. Retries are attempted at the replication interval specified in the Preferences dialog 
box.

The file where database update operations are saved is JET.LOG. This file is used by WINS to recover data if
necessary. You should back up this file when you back up other files on the WINS server. 

Advanced WINS Server Configuration Options

Logging Enabled
Log Detailed Events
Replicate Only with Partners
Backup On Termination
Migrate On/Off
Starting Version Count
Database Backup Path

See Also

Setting Preferences for WINS Manager



Pull Partner

A WINS server that pulls in replicas of database entries from its partner by requesting and then accepting 
replicas. 



Push Partner

A WINS server that sends update notification messages to its partner when its WINS database has changed. 
When its partner responds to the notification with a replication request, the push partner sends a copy of its 
current WINS database to the partner.
For the databases on the primary and backup WINS servers to remain consistent, they must be both push and 
pull partners with each other. It is always a good idea for replication partners to be both push and pull partners 
of each other.



Configuring Replication Partners

Each WINS server is a push partner or pull partner with at least one other WINS server. 
WINS servers communicate among themselves to fully replicate their databases, ensuring that a name 
registered with one WINS server is eventually replicated to all other WINS servers within the internetwork. All 
mapping changes converge within the replication period for the entire WINS system, which is the maximum time 
for propagating changes to all WINS servers. All released names are propagated to all WINS servers after they 
become extinct, based on the interval set in WINS Manager.
Replication is carried out among replication partners, rather than each server replicating to all other servers.
Replication is triggered when a WINS server polls another server to obtain a replica. Polling can begin at system 
startup and can then repeat at the time interval specific for periodic replication. Replication is also triggered 
when a WINS server reaches a threshold set by the administrator, which is an update count for registrations and 
changes. In this case, the server notifies its partners that it has reached this threshold, and the other servers 
then decide to pull replicas. Additionally, the administrator can cause a replication immediately or at a specified 
time. Replication at a specified time is a one-time only event. If the time specified has already passed, 
replication does not occur. 

See Also

Adding a Replication Partner for a WINS Server
Configuring Replication Partner Properties
Triggering Replication Between Partners



Adding a Replication Partner for a WINS Server

To add a replication partner for a WINS server

1 On the Server menu, click Replication Partners.
This command is available only if you are logged on as a member of the Administrators group for the local 
server.

2 Click Add, type the name or IP address of the WINS server that you want to add to the list, and then click OK.
If WINS Manager can find this server, it will add it to the WINS Server list in the Replication Partners dialog
box. 

4 In the WINS Server list, click the server you want to configure, and then complete the actions described in 
Configuring Replication Partner Properties.

5 If you want to view only push partners or pull partners, or WINS servers that are neither push partners nor pull 
partners, click:

Push Partners to display push partners for the current WINS server.
Pull Partners to display pull partners for the current WINS server.
Other to display the WINS servers that are neither push partners nor pull partners for the current WINS 

server.
6 To specify replication triggers, follow the procedures described in Triggering Replication Between Partners.

To delete replication partners

1 On the Server menu, click Replication Partners.
2 Click one or more servers in the WINS Server list, and then click Delete.

WINS Manager asks you to confirm the deletion if you selected the related confirmation option in the 
Preferences dialog box.

See Also

Configuring Replication Partner Properties
Triggering Replication Between Partners



Configuring Replication Partner Properties

When you designate replication partners, you need to specify parameters for push partners and pull partners 
that govern when replication will begin.

To configure replication partners for a WINS server

1 In the WINS Server list of the Replication Partners dialog box, click the server you want to configure.
2 Click either Push Partner or Pull Partner to indicate the replication option you want, and then click 

Configure.
3 Complete the entries in the Properties dialog box, as described in the following procedures.

To define push partner properties
In the Update Count box of the Push Partner Properties dialog box, type a number for how many 

additions and updates can be made to records in the database before the changes result in replication.
Replications that have been pulled in from partners do not count as insertions or updates in this context. The 
minimum is 20.

Note
To return to the value specified in the Preferences dialog box, click Set Default Values.

To define pull partner properties

1 In the Start Time box of the Pull Partner Properties dialog box, type a time to indicate when replication 
should begin.
You can use any separator for hours, minutes, and seconds. Any AM or PM designations will work, but only if 
these are configured for your system’s time setting options.

2 In the Replication Interval box, type a time in hours, minutes, and seconds to indicate how often replications
will occur, or click the spin buttons to set the time you want.
If you want to return to the values specified in the Preferences dialog box, click Set Default Values.



Triggering Replication Between Partners

You can replicate the database between the push partners or pull partners immediately, rather than waiting for 
the start time or replication interval specified in the Preferences dialog box, as described in Setting Preferences
for WINS Manager. 
You will probably want to begin replication immediately after you make a series of changes, such as entering a 
range of static address mappings.

To send a replication trigger

1 On the Server menu, click Replication Partners.
2 In WINS Servers list box, click the WINS servers to which you want to send a replication trigger, and then 

click Push or Pull, depending on whether you want to send the trigger to push partners or pull partners.
3 Optionally, you can select the Push With Propagation check box if you want the specified WINS server to 

propagate the trigger to all its pull partners after it has pulled in the latest information from the source WINS 
server. If it does not need to pull in any replicas because it has the same or more up-to-date replicas than the 
source WINS server, then it does not propagate the trigger to its pull partners.
Otherwise, if the Push With Propagation check box is cleared, the specified WINS server will not propagate 
the trigger to its other partners. 

To start replication immediately
In the Replication Partners dialog box, click Replicate Now.

See Also

Setting Preferences for WINS Manager



Filtering the Range of Mappings

You may want to limit the range of IP addresses or computer names displayed in the Static Mappings dialog 
box or the Show Database dialog box.

To filter mappings by address or name

1 In the dialog box for Static Mappings or Show Database, click Set Filter.
2 In the Computer Name or IP Address boxes, type a portion of the computer name or the address or both, 

plus asterisks for the unspecified portions of the name or address.
You can use the asterisk (*) wildcard for either the name or address. However, for the address, a wildcard can 
be used only for a complete octet. For example, you can type 11.101.*.*, but you cannot enter 11.1*.1.1

3 Click OK.
The selected range appears in the Static Mappings or Show Database dialog box. If no mappings are found
that match the range you specified, the list will be empty.

To clear the filtered range of mappings
In the Static Mappings or Show Database dialog box, click Clear Filter.



Managing Static Mappings for WINS Servers

Static mappings are permanent lists of computername-to-address mappings that cannot be challenged or 
removed, except when the administrator removes the specific mapping. You use the Static Mappings command 
in WINS Manager to add, import, or delete static mappings for clients on the network that are not WINS enabled.

To view static mappings

1 On the Mappings menu, click Static Mappings.
2 Click a Sort Order option, either by IP Address or by Computer Name.
3 To edit or add a mapping, follow the procedures described in Editing Static Mappings and Adding Static 

Mappings.
4 To remove an existing static mapping, click it in the list, and then click Delete Mapping.
5 To limit the range of mappings displayed in the list of static mappings, click Set Filter and then follow the 

procedure under Filtering the Range of Mappings.
6. To turn off filtering, click Clear Filter.

Important
You cannot cancel changes made to the WINS database while working in the Static Mappings dialog box. 

You must manually delete any entries that are added in error or manually add back any entries that you mistakenly 
delete. This is because all changes to the WINS database made in this dialog box take effect immediately.

See Also

Editing Static Mappings
Adding Static Mappings
Filtering the Range of Mappings



Editing Static Mappings

You can change the IP addresses in static mappings owned by the WINS server you are currently administering.

To edit a static mapping entry

1 In the Static Mappings dialog box, click the mapping you want to change and then click Edit Mapping.
2 In the IP Address box, type a new address for the selected computer, and then click OK.

The change is made in the WINS database immediately. If the change you enter is not allowed for the 
database because that address is already in use, a message asks you to enter another address.

Note
You can view, but not edit, the Computer Name and Mapping Type mapping option in the Edit Static 

Mappings dialog box. If you want to change the Computer Name or Mapping Type related to a specific IP 
address, you must delete the entry and redefine it in the Add Static Mappings dialog box. 



Adding Static Mappings

You can add static mappings to the WINS database for specific IP addresses using one of two methods:
Adding Static Mappings by Typing Entries
Importing Entries for Static Mappings



Adding Static Mappings by Typing Entries

It is important to note that, because each static mapping is added to the database when you click Add, you 
cannot cancel work in this dialog box. If you make a mistake when entering a name or address for a mapping, 
you must return to the Static Mappings dialog box and delete the mapping there.

To add static mappings to the WINS database by typing entries

1 In the Static Mappings dialog box, click Add Mappings.
2 In the Computer Name box, type the computer name of the system for which you are adding a static 

mapping.
3 In the IP Address box, type the address for the computer.
4 Click a Type option to indicate whether this entry is a unique name or a kind of group, as described in the 

following list:
Unique
Group
Domain Name
Internet Group
Multihomed

5 If you specified a Domain Name, Internet group, or Multihomed type, additional controls appear so that 
you can add multiple addresses to the list. Click an address in the list, and then click Up or Down to change 
its order in the list.

6 Click Add.
The mapping is immediately added to the database for that entry, and the boxes are cleared so that you can 
add another entry.

7 Repeat this process for each static mapping you want to add to the database, and then click Done.

See Also

Using Type Options



Importing Entries for Static Mappings

You can also import entries for static mappings from any file that has the same format as the LMHOSTS file. 
Scope names and keywords other than #DOM are ignored.

To import a file containing static mapping entries

1 In the Static Mappings dialog box, click Import Mappings.
2 Specify a filename for a static mappings file by typing its name in the box, or click one or more filenames in 

the list, and then click OK to import the file.
Each specified file is read, and a static mapping is created for each computer name and address. If the #DOM 
key word is included for any record, a special group is created (if it is not already present), and the address is 
added to that group.

See Also

Viewing the WINS Database



Using Type Options

WINS recognizes special names for normal groups, multihomed devices, domain names, and internet groups. The
following topics describes these special names and presents some background details to help you understand 
how WINS manages these groups.
Normal Group Type
Multihomed Type
Domain Name Type
Internet Group Type

Handling Special Names

Special names are indicated by a 16th byte appended to the computer name or domain name. The following list 
shows some special names that can be defined for static entries in the Add Static Mappings dialog box.:
0x1E: A Normal Group
0x1D: Clients resolve this name to access the Master Browser for server lists
0x1C: A Domain Name Group
0x20: An Internet Group



Normal Group Type

A group name does not have an address associated with it. It can be valid on any subnet and can be registered 
with more than one WINS server. A group's expiration date shows the time it will expire. If the WINS server 
receives a query for the group name, it returns FFFFFFFF (the limited broadcast address). The client then 
broadcasts on the subnet. The group name is renewed when any member of the group renews the group name.



Multihomed Type

A multihomed name is a single, unique name that stores multiple addresses. A multihomed device is a computer 
with multiple network cards bound to NetBIOS over TCP/IP. A multihomed device with multiple IP addresses can 
register one or more addresses by sending them in a special name registration packet. A multihomed name in a 
WINS database can have one or more addresses. The expiration date for the record reflects the time it will 
expire. 
Each multihomed group name can contain a maximum of 25 IP addresses.
The WINS service should not be run on a computer that has two or more network cards (mulithomed) on 
disjointed networks.
MS-DOS clients that query WINS may not be able to reach computers with multiple network cards that straddle 
disjointed networks because the MS-DOS clients always pick the first IP address supplied by the WINS server. If 
all the multihomed computer's addresses cannot be reached from the MS-DOS client, the client may fail to 
connect to that computer because it may be using one of the unreachable addresses supplied by the WINS 
server.
You can configure a multihomed computer to register with different WINS servers for each adapter card. If the 
multihomed computer straddles two disjointed networks, the computers on either side would use the WINS 
server on their network to resolve names and WINS would return only the IP address registered on the requesting
client’s network.
A larger problem arises if the multihomed computer is also running WINS since that computer always registers 
its names with the local WINS. Therefore, it is not possible for a multihomed computer running WINS to register 
with two different WINS servers, if its adapters are on disjointed networks.
Note that a computer can have a maximum of 64 network cards. Any cards beyond 64 will be ignored. 

Multihomed Computer Node Type
A computer can be one of four node types: broadcast node, mixed node, point-to-point node, or hybrid node. The
node type cannot be specified by network adapter card. In some circumstances, you may want to have one or 
more network adapter cards function as broadcast nodes and other network adapter cards to function as 
hybrids. 
To do this, set the node type to broadcast node, and configuring WINS name server addresses for the network 
adapter cards that will function as hybrids. The presence of the WINS addresses will effectively override the 
broadcast node setting for the adapters on which they are set.
To designate a Broadcast node, configure DHCP to set the node type to B-node. In the absence of DHCP, a 
computer will assume B-node behavior by default.



Domain Name Type

In Windows NT 3.51, the Domain Name type was known as the Internet Group type. With Windows NT 4.0, there 
is a new Internet Group type.
The domain-name group name is read as configuration data. When dynamic name registrations for domain name
groups are received, the actual address (rather than the subnet broadcast address) is stored in the group with an
expiration date and the owner ID, which indicates the WINS server registering that address. 
The domain-name group name is handled specially by WINS, which returns the 24 closest Windows NT Server 
computers in the domain, plus the domain controller. The name ending in 1C is also used to identify a 
Windows NT Server computer in a domain when a computer running Windows NT Workstation or Windows NT 
Server needs a server for pass-through authentication.
The domain-name group name (which has a 16th byte ending in 0x1C reserved for domain names, as described 
below) can contain a maximum of 25 IP addresses for primary or backup domain controllers in a domain. 
Dynamically registered names are added if the list is not static and has fewer than 25 members. If the list has 25
members, WINS removes a replica member (that is, a member registered by another WINS server) and adds the 
new member. If all members are owned by this WINS server, the oldest member is replaced by the new one.
WINS prefers members in a domain-name group name that are registered. This preference means that the group 
name always contains the geographically closest computers running Windows NT Server. To establish the 
preference of members of domain name groups registered with other WINS servers under the \Partners\Pull key 
in the Registry, a precedence is assigned for each WINS partner as a value of MemberPrec. Preference should 
be given to WINS servers and clients that are closest to the WINS server you are configuring.
If your network still has domain controllers running Windows NT Advanced Server version 3.1 to be included in 
the domain-name group name, you must add these to the group manually using WINS Manager. When you 
manually add such a computer to the domain-name group name, the list becomes static and no longer accepts 
dynamic updates from WINS-enabled computers. 



Internet Group Type

An internet group name is a user-defined, special group used to store member addresses. When you create an 
internet group, you have the option of specifying up to 25 member addresses. Member addresses entered in this 
manner are considered permanent and remain on the list indefinitely. The only way to remove them is with WINS
Manager.
Any members added as a result of dynamic group registration will not replace permanent members; they will 
simply fill up the remainder of the unfilled list positions. If the list has 25 members, WINS removes a replica 
member (that is, a member registered by another WINS server), and adds the new member. If all members are 
owned by this WINS server, the oldest member is replaced by the new one.
The rules for establishing member precedence are the same as those for domain-name group types.
You do not have to specify any member addresses when you create an internet group, in which case all 25 list 
positions are available for dynamic group registrations.
WINS will only replicate internet groups if they contain member addresses.
When an application queries WINS for an internet group, WINS returns the list of member addresses. If the 
application sends a message to an internet group, all members of the group receive it. For example, an 
application could send a status request message to a group of printers or Internet servers, and then pick the first
one that indicates its availability in a response message.



0x1E

Browsers broadcast to this name and listen on it to elect a master browser. There is one master browser on a 
subnet. The broadcast is done on the local subnet and should not cross routers. WINS always returns the limited 
broadcast address (FFFFFFFF).



0x1D

WINS always returns a negative response. If possible, the client then broadcasts a name query to resolve the 
name. For registrations, WINS returns a positive response even though the names are not stored in the database.



0x1C

This name contains a list of the specific addresses of systems that have registered the name. The domain 
controller registers this name. WINS treats this as a domain name group, where each member of the group must 
renew its name individually or be released. This is limited to 25 names; however, there is no limit to the number 
of #DOM entries allowed in LMHOSTS.
WINS returns a positive response for a dynamic registration of a static 1C name, but the address is not added to 
the list. When a static 1C name is replicated that clashes with a dynamic 1C name on another WINS server, a 
union of the members is added, and the record is marked as static. If the record is static, members of the group 
do not have to renew their IP addresses.



0x20

Internet group names, by default, end with 0x20, but you can override this by appending a new character in 
brackets ([]) at the end of the name. Note, however, that 0x1C is reserved for domain name groups and not 
allowed as the 16th character in internet group names. This name contains a list of the specific addresses of 
systems that have registered the name. WINS treats this as an internet group, where each member of the group 
must renew its name individually or be released. This is limited to 25 names. However, there is no limit to the 
number of #SG entries allowed in LMHOSTS.
WINS returns a positive response for a dynamic registration of a static internet group member, and the member 
address is added to the list. When a static internet group name is replicated that clashes with a dynamic internet
group name on another WINS server, a union of the members is added, and the record is marked as static. If the 
record is static, members of the group do not have to renew their IP addresses.



Scavenging the Database

Like any database, the WINS database of address mappings needs to be cleaned and backed up periodically to 
be cleared of released entries and old entries that were registered at another WINS server but did not get 
removed from this database for some reason. This process, called scavenging, is done automatically over 
intervals defined by the relationship between the Renewal and Extinction intervals defined in the 
Configuration dialog box.
WINS Manager provides the tools you need for maintaining the database. For example, if you want to verify old 
replicas immediately instead of waiting the time interval specified for verification, you can manually scavenge 
the database.

To scavenge the WINS database
On the Mappings menu, click Initiate Scavenging.

Note
The following files are stored in the \\%SystemRoot%\System32\WINS folder, which is created when you set

up a WINS server:
Jet.log is log of all transactions done with the database. This file is used by WINS to recover data if 

necessary.
System.mdb is used by WINS for holding information about the structure of its database.
Wins.mdb is the WINS database file.
Winstmp.mdb is a temporary file that WINS creates. This file may remain in the \\WINS folder after a crash.

You should back up these files when you back up other files on the WINS server. After WINS has been running 
for a while, the database might need to be compacted to improve WINS performance. For example, you should
compact the WINS database whenever it approaches 30 MB.

To compact the WINS database

1 To stop the Windows Internet Name Service, on the WINS server, click Control Panel Services.
Or, type net stop wins at the command prompt.

2 Run the Jetpack.exe program (which is found in the \%SystemRoot%\System32 folder).
3 Restart the Windows Internet Name Service on the WINS server.

Important
The Jet.log, System.mdb, Wins.mdb, and Winstmp.mdb files should not be removed or tampered with in 

any other manner.

See Also

Configuring WINS Servers



Backing Up and Restoring the Database

The WINS Manager provides backup tools so that you can back up and restore the WINS database. After you 
specify a backup folder for the database, WINS performs complete database backups every three hours, using 
the specified folder.

To back up a WINS database

1 On the Mappings menu, click Backup Database.
2 Type or enter the location for saving the backup files, and then click OK.

Important
Do not specify a network drive as the backup location.

To restore a WINS database

1 On the Mappings menu, click Restore Database.
2 Type or enter the location where the backup files are stored, and then click OK.

Notes
In case of database corruption, the WINS database can be restored from the backup. Regardless of whether

the WINS database is restored, use WINS Manager to do the following before invoking WINS after such a corruption:
In the Show Database dialog box, check the highest version number of records owned by this WINS 

server in the database of its present and past partners (that is, check all WINS servers to which the records may 
have been replicated). If a WINS server is currently down, you will need to start it to check its database for the 
version number information.

In the WINS Server Configuration dialog box, set a value for Starting Version Count that is higher 
than the highest version number on the other WINS servers. This number will not be accepted by WINS if it is set to 
more than 2^31. Also note that WINS may adjust the value you specify to a higher one to ensure that database 
records are replicated to other WINS servers quickly. Typically, the adjustment will be an increment in the range of 0
to 500.



Viewing the WINS Database

You can view the actual active and static mappings stored in the WINS database, based on the WINS server that 
owns the entries.

To view the entire WINS database at a specific server

1 On the Mappings menu, click Show Database.
2 Click Show Only Mappings From Specific Owner.
3 In the Select Owner list, click the WINS server whose database you want to view.

By default, the Show Database dialog box shows all mappings for the WINS database on the currently 
selected WINS server.

3 Click one of the Sort Order options to sort the mapping by IP Address, Computer Name, Version ID, Type, or 
Expiration Date.

4 Use the scroll bars in the Mappings box to view entries in the database.

To view a specified range of mappings within the WINS database

1 Click Set Filter and follow the procedures described in Filtering the Range of Mappings. 
2 To turn off filtering, click Clear Filter.

Notes
As shown in the Mappings list, each registration record in the WINS database includes the following 

elements:
 = Unique
 = Group, domain name, internet group, or multihomed

Computer name = The NetBIOS computer name.
IP address = The assigned Internet Protocol address.
A or S = Whether the mapping is active or static.
Expiration Date = Shows the time when the record will expire.
Version ID = A unique hexadecimal number assigned by the WINS server during name registration, which is used by
the server's pull partner during replication to find new records.

You can also use the Show Database dialog box to remove all references to a specific WINS server in the 
database, including all database entries owned by the WINS server.

To delete a specific WINS server's entries in the database
In the Show Database dialog box, click a WINS server in the Select Owner list, and then click Delete 

Owner.

See Also

Filtering the Range of Mappings
Adding Static Mappings



Setting Preferences for WINS Manager

You can configure several options for administration of WINS servers. The commands for controlling preferences 
are on the Options menu.

To display the status bar for help on commands
On the Options menu, click Status Bar.

When this command is active, its name is checked on the menu, and the status bar at the bottom of the WINS 
Manager window displays descriptions of commands as they are highlighted in the menu bar.

To set preferences for the WINS Manager

1 On the Options menu, click Preferences. 
2 To see all the available preferences, click Partners.
3 Click an Address Display option to indicate how you want address information to be displayed throughout 

WINS Manager  as computer name, IP address, or an ordered combination of both.
4 Click Auto Refresh if you want the statistics in the WINS Manager window to be refreshed automatically. 
Then type a number in the Interval box to specify the number of seconds between refresh actions.

WINS Manager also refreshes the statistical display automatically each time an action is initiated while you are
working in WINS Manager.

5 Click LAN Manager-Compatible if you want computer names to adhere to the LAN Manager naming 
convention.
Windows NT follows the LAN Manager convention, so this box should be selected unless your network accepts 
NetBIOS names from other sources.

6 If you want the system to query the list of servers for available servers each time the system starts, click 
Validate Cache Of Known WINS Servers At Startup Time.

7 If you want a warning message to appear each time you delete a static mapping or the cached name of a 
WINS server, click Confirm Deletion Of Static Mappings And Cached WINS Servers.

8 In the Start Time box, type a time to specify the default for replication start time for new pull partners. Then 
specify values for the Replication Interval to indicate how often data replicas will be exchanged between the
partners. 
The minimum value for the Replication Interval is five hours.

9 In the Update Count box, type the number of registrations and changes that can occur locally before a 
replication trigger is sent by this server when it is a push partner.
The minimum value is 20.

Note
Which Address Display option you select determines how a connection is made to the WINS server. For IP

addresses, the connection is made via TCP/IP; for computer names, the connection is made via named pipes.



Detailed Information

The Detailed Information dialog box appears when you click Detailed Information on the Server menu.

Fields
WINS Server Address
Last Scavenging Times
Unique Registrations
Group Registrations
For descriptions of the related intervals, see Configuring WINS Servers. 



Last Scavenging Times
Periodic indicates when the database was cleaned based on the renewal interval specified in the WINS 

Server Configuration dialog box.
Admin Trigger indicates when the database was last cleaned because the administrator selected Initiate

Scavenging.
Extinction indicates when the database was last cleaned based on the Extinction interval specified in the 

WINS Server Configuration dialog box.
Verification indicates when the database was last cleaned based on the Verify interval specified in the 

WINS Server Configuration dialog box.

See Also

Scavenging the Database



Unique Registrations

The number of name registration requests that have been accepted by this WINS server.
Unique Conflicts shows the number of conflicts encountered during registration of unique names owned 

by this WINS server.
Unique Renewals shows the number of renewals received for unique names.



Group Registrations

The number of registration requests for groups that have been accepted by this WINS server:
Group Conflicts shows the number of conflicts encountered during registration of group names.
Group Renewals shows the number of renewals received for group names.

For information about groups, see Using Type Options.



WINS Server Address

Specifies options that describe the values for identifying this particular server:
Computer Name identifies this computer on the Windows NT network.
IP address is the unique four-octet address assigned to this computer.
Connected Via shows the network protocol for the connection.
Connected Since shows how long this computer has been online.
Last Address Change indicates the time at which the last WINS database change was replicated.



WINS Server Configuration

The WINS Server Configuration dialog box appears when you click Configuration on the Server menu. Use 
this dialog box to specify options that define intervals for managing the database and relationships with 
replication partners.

Fields:
Advanced Button
Renewal Interval
Extinction Interval
Extinction Timeout
Verify Interval
Pull Parameters
Push Parameters
Logging Enabled
Log Detailed Events
Replicate Only with Partners
Backup On Termination
Migrate On/Off
Starting Version Count
Database Backup Path

See Also

Configuring WINS Servers



Advanced Button

Click this to display additional items for advanced WINS server configuration.



Logging Enabled

Specifies whether to log database changes in the Jet.log file.



Log Detailed Events

Specifies that event logs include detailed information. This requires considerable system resources and should 
be turned off if you are tuning for performance.



Replicate Only With Partners

Specifies that replication will be done only with WINS pull or push partners. If this option is not checked, an 
administrator can ask a WINS server to pull or push from or to a non-listed WINS server partner. 



Backup On Termination

Specifies that the database will be backed up automatically when the WINS Service is stopped, except when the 
system is being shut down.



Migrate On/Off

Specifies that static unique and multihomed records in the database are treated as dynamic when they conflict 
with a new registration or replica. This means that if they are not longer valid, they will be overwritten by the 
new registration or replica. Select this option if you are upgrading non-Windows NT systems to Windows NT. By 
default, this option is not selected.



Starting Version Count

Specifies the highest version ID number for the database. Change this value to a higher value if the database 
becomes corrupted and needs to start fresh. In such a case, set this value to a number that is higher than the 
version number counter that appears for replications of this WINS server's records on all its remote partners. 
WINS may adjust the value you specify to a higher one to ensure that database records are quickly replicated to 
other WINS Servers. The maximum allowable value is 231 - 1. This value appears in the View Database dialog 
box in WINS Manager.



Renewal Interval 

Specifies how often a client reregisters its name. The default renewal interval for records in the WINS database is
four days. WINS clients will register and refresh every two days. This setting reduces network traffic and allow 
WINS to service many more nodes than before.



Extinction Interval 

Specifies the interval between when an entry is marked as released and when it is marked as extinct. The 
default is dependent on the renewal interval and, if the WINS server has replication partners, on the maximum 
replication time interval. The maximum allowable value is four days.



Extinction Timeout 

Specifies the interval between when an entry is marked extinct and when the entry is finally scavenged from the 
database. The default is dependent on the renewal interval and, if the WINS server has replication partners, on 
the maximum replication time interval.



Verify Interval 

Specifies the interval after which the WINS server must verify that old names that it does not own are still active.
The default is dependent on the extinction interval. The minimum allowable value is 24 days.



Pull Parameters

Governs how this server pulls replicas from its partners.
Click Initial Replication to specify whether this WINS server pulls replicas from known partners whenever the 
system is initialized or whenever a replication-related parameter is changed. For example, this could be when a 
partner is added or deleted or a parameter specific to a partner is changed.
Type a number in the Retry Count box to specify the number of times the server should attempt to connect (in 
case of failure) with a partner for pulling replicas. Retries are attempted according to the value for the 
Replication Interval specified in the Preferences dialog box. After the specified number of retries, the server 
stops for a while before retrying again. The interval for this time is about three times the Replication Interval.



Push Parameters

Governs how this server pushes replicas from its partners.
Click Initial Replication to specify that this server will inform pull partners of the database status when the 
system is initialized or Replicate On Address Change to specify that this server will inform pull partners of the
database status when an address changes in a mapping record.



Database Backup Path

Specifies the path to the folder where the backup copies of the database are to be stored. If you specify a backup
path, WINS automatically performs a full backup of its database to this folder every three hours.
Type the path to the backup folder, or use Browse to find it. 
Do not specify a network drive as the backup location.
WINS uses this folder to automatically    restore the database in the event that the database is found to be 
corrupted when WINS is started.



Replication Partners

The Replication Partners dialog box appears when you click Replication Partners on the Server menu.

Fields
WINS Server
WINS Servers to List
Replication Options
Send Replication Trigger Now
Add Button
Delete Button
Replicate Now Button

See Also

Adding a Replication Partner for a WINS Server
Configuring Replication Partner Properties
Triggering Replication Between Partners



WINS Server

Identifies a list of WINS servers that are replication partners with the server identified in the title bar.
Check marks identify whether the server in the list is a push partner or a pull partner. A server can be both a 
push partner and a pull partner, or neither.



Replication Options

Specifies replication options for the selected server.
Click either Push Partner or Pull Partner to specify the kind of replication partner for the selected server. Click
Configure to display either the Push Partner Configuration dialog box or Pull Partner Configuration dialog
box.



Send Replication Trigger

Specifies options that cause start replication information to be sent to replication partners.
Click Push or Pull to send the replication trigger as specified in the Push (or Pull) Partner Configuration 
dialog box to the replication partners.
Optionally, you can select the Push With Propagation check box if you want the selected WINS server to 
propagate the trigger to all its pull partners after it has pulled in the latest information from the source WINS 
server. If it does not need to pull in any replicas, then it does not propagate the trigger. If the Push With 
Propagation check box is not selected, the selected WINS server will not propagate the trigger to its other 
partners.



Add Button

Click Add to display an Add dialog box for selecting a WINS server to add to the list.



Delete Button

Click Delete to remove a selected WINS server from the list of replication partners.



WINS Servers to List

If you want to view only push partners or pull partners, or WINS servers that are neither push partners nor pull 
partners, click:

Push Partners to display push partners for the current WINS server.
Pull Partners to display pull partners for the current WINS server.
Other to display the WINS servers that are neither push partners nor pull partners for the current WINS 

server.



Replicate Now Button

Starts database replication immediately.



Add WINS Server

Use the Add WINS Server dialog box to specify the NetBIOS computer name or the IP address of the WINS 
server that you want to select.
This dialog box appears when you click Add WINS Server on the Server menu or when you click Add in the 
Replication Partners dialog box.
In the WINS Server box, specify either the Computer Name or IP Address of the WINS server that you want 
to add to the list of replication partners. 
If you type a computer name, you do not have to include the double backslashes (\\). WINS Manager will add 
these for you.
After you click OK, WINS Manager will make sure it can find this computer before adding it to the WINS Server 
list.

See Also

Administering WINS Servers
Connecting to a WINS Server



Pull Partner Properties

The Pull Partner Properties dialog box appears when you click Configure by the Pull Partner option in the 
Replication Partners dialog box.

Fields
Pull Partner
Start Time
Replication Interval
Set Default Values Button

See Also

Adding a Replication Partner for a WINS Server
Configuring Replication Partner Properties
Triggering Replication Between Partners



Pull Partner

Identifies the WINS server for which these parameters are defined.



Start Time

Allows you to specify a time to indicate when replication should begin.



Replication Interval

Allows you to specify a time to indicate how often replications will occur.



Set Default Values Button

Click this to return values to those specified in the Preferences dialog box.



Push Partner Properties

The Push Partner Properties dialog box appears when you click Configure by the Push Partner option in the
Replication Partners dialog box.

Fields
Push Partner
Update Count
Set Default Values Button

See Also

Adding a Replication Partner for a WINS Server
Configuring Replication Partner Properties
Triggering Replication Between Partners



Push Partner

Identifies the WINS server for which these parameters are defined.



Update Count

Allows you to specify a number for how many updates are made to locally owned records in the database before 
partners the are informed of changes.



Set Filter

The Set Filter dialog box appears when you click Set Filter in the dialog box for Static Mappings or Show 
Database. You can limit the range of addresses displayed in the originating dialog box.
In the Computer Name box, specify a portion of the computer name to be filtered, plus asterisks for the 
unspecified portions of the name (for example, acct*).
In the IP Address box, specify a portion of the address to be filtered, plus asterisks for the unspecified portions 
of the address (for example, 11.101.*.*).



Static Mappings

The Static Mappings dialog box appears when you click Static Mappings on the Mappings menu. 

Fields
Filter
Set Filter Button
Clear Filter Button
Add Mappings Button
Import Mappings Button
Edit Mapping Button
Delete Mapping Button
Sort Order



Sort Order

Specifies how mappings are sorted. Click Sort Static Mappings By IP Address to specify that mappings will 
be sorted by address; click Sort Static Mappings By Computer Name to specify that mappings will be sorted 
by NetBIOS computer name.



Filter

Shows the current filter set for the list of static mappings.



Edit Mapping Button

Displays the Edit Static Mapping dialog box for changing the name or address for a selected mapping in the 
list.



Delete Mapping Button

Deletes the selected mappings in the list. More than one mapping can be selected from the list.



Set Filter Button

Displays the Set Filter dialog box for specifying a range of mappings to filter out.



Clear Filter Button

Turns off the range of filters specified with the Set Filter.



Add Mappings Button

Displays the Add Mappings dialog box, which enables you to add static mappings to the WINS database.



Import Mappings Button

Displays the Select Static Mapping File dialog box. Use this option to import entries for static mappings from 
any file that has the same format as the LMHOSTS file.



Edit Static Mapping

This dialog box appears when you click Edit Mappings in the Static Mappings dialog box.

Fields
Computer Name
Mapping Type
IP Address

See Also

Editing Static Mappings



Computer Name

Identifies the NetBIOS computer name. You cannot edit this value.



Mapping Type

Identifies the mapping type as follows:
    Unique 
    Group (normal group, domain name, internet group, or multihomed)

You cannot edit this value. See Using Type Options.



IP Address

Allows you to specify the static address to be assigned to this name.



Add Static Mappings

This dialog box appears when you click Add Mappings in the Static Mappings dialog box. Click Close to 
accept all changes and close the dialog box.

Fields
Name
IP Address
Unique
Group
Domain Name
Internet Group
Multihomed
Add Button

See Also

Using Type Options
Adding Static Mappings



Name

Allows you to specify the computer name of the system for which you are adding a static mapping.



IP Address

Allows you to specify the address for the computer.



Unique

Allows you to specify a unique name in the database, with one address per name.



Group

Allows you to specify a normal group, where addresses of individual members are not stored. The client 
broadcasts name packets to normal groups.



Domain Name

Allows you to specify a group with NetBIOS names that have 0x1C as the 16th bytes. An domain name group 
stores up to 25 addresses for members. For registrations after the 25th address, WINS overwrites a replica 
address or, if none is present, it overwrites the oldest registration.
If you choose this option, additional controls appear so that you can add multiple addresses to the list. Click an 
address in the list, and then click Up or Down to change its order in the list. 



Internet Group

Internet groups are user-defined, special groups that store up to 25 addresses for members. Click this option to 
specify your own group of NetBIOS names and IP addresses.
By default, a space character (0x20) is appended to the name as the 16th byte. You can override this by placing 
a new character in brackets at the end of the internet group name. WINS will pad the name with spaces up to the
15th character and use the new character (the one in brackets) as the 16th character. Note, however, that 0x1C 
is reserved for domain name groups and not allowed as the 16th character in internet group names.
You can also enter non-printable characters in the internet group name. Use the backslash (\) character followed 
by the decimal or hexadecimal value of the non-printable character. For example, \255 or \0xFF.
If you choose this option, additional controls appear so that you can add multiple addresses to the list. Click an 
address in the list, and then click Up or Down to change its order in the list. 



Multihomed

Allows you to specify a unique name that can have more than one address (multihomed computers). The 
maximum number of addresses is 25. For registrations after the 25th address, WINS overwrites a replica address 
or, if none is present, it overwrites the oldest registration.
If you choose this option, additional controls appear so that you can add multiple addresses to the list. Click an 
address in the list, and then click Up or Down to change its order in the list. 



Add Button

Click this to immediately add the entry to the database, and then clear the boxes so you can add another entry.



Select Static Mapping File

This dialog box appears when you click Import Mappings in the Static Mappings dialog box. Use the Select 
Static Mapping File dialog box to specify the path to a file that you would like to open.

Fields
File Name
List Files of Type
Directories
Drives
Network Button



File Name

Displays the default file specification and a list of the files in the current folder. Type the name of the file you 
want to open, or click a filename in the list.



List Files of Type

Lists the available file formats. You can open the list box to select different formats.



Directories

Lists the current directory (folders) and any subdirectories (folders within folders). You can double-click different 
folders to change your path.



Drives

Lists the available drives. You can open the list box to select a different drive.



Network Button

Displays the Connect Network Drive dialog box so that you can connect to and browse a network drive.



Initiate Scavenging

Begins the process of cleaning the database. For details, see Scavenging the Database.



Select Backup or Restore Directory

These dialog boxes appear when you click Backup Database or Restore Database on the Mappings menu.

After you specify a backup folder (directory) for the database, WINS performs complete database backups every 
three hours, using the specified folder.

Fields
Directories
Drives
Network Button



Show Database

This dialog box appears when you click Show Database on the Mappings menu.

Fields
Owner
Select Owner and Highest ID
Sort Order
Filter
Mappings List
Set Filter Button
Refresh Button
Delete Owner Button

See Also

Viewing the WINS Database



Refresh Button

Click this to update the WINS database display in the Mappings list.



Delete Owner Button

Click this to removes all references to the selected WINS server in the database, including all database entries 
owned by the WINS server. In the Select Owner list, click the WINS server that you want to delete, and then 
click Delete Owner.



Owner

Specifies whether all entries in the database or only entries that originated from a specific WINS server will 
appear. Click Show All Mappings to display all mappings in the database; click Show Only Mappings From 
Specific Owner if you only want to see the entries that originated from a certain WINS server. If you select the 
latter option, you must also select a WINS server from the Select Owner list.



Select Owner

Lists all the WINS servers known by the current WINS server. You can click the WINS server in the list that owns 
the mappings that you want to view. The Highest ID value shows the highest version number of records owned 
by this WINS server in the database of its replication partners.



Sort Order

Specifies how the list of mappings is sorted. Click Sort by IP Address to sort the list in address order; Sort by 
Computer Name to sort the list alphabetically by computer name; Sort by Expiration Date to sort the list 
according to the time they will expire in the database; Version ID to sort the list by the version ID number 
(when you need to find the highest version number after a server failure, for example); or Sort by Type to sort 
the list by type, as described in Using Type Options.



Filter

Shows the current filter set using Set Filter.



Mappings List

Shows a list of registration records in the WINS database:
 indicates the mapping is a Group, Domain Name, Internet Group, or MUL=Multihomed.
A / S shows whether the mapping is Active or Static.
Expiration Date shows the time when the record will expire. 
Version shows a unique number assigned by the WINS server during name registration, which is used by the 

server's pull partner during replication to find new records.

See Also

Using Type Options



Set Filter Button

Click this to specify a range of mappings to filter out.



Clear Filter Button

Click this to turn off the range of filters specified using Set Filter.



Preferences

This dialog box appears when you click Preferences on the Options menu. Click one of the following buttons 
for more information about this dialog box:
Partners Button
Address Display
Server Statistics
Computer Names
Miscellaneous
New Pull Partner Default Configuration
New Push Partner Default Configuration

See Also

Setting Preferences for WINS Manager



Partners Button

Click this to display additional options for configuring default configuration for new replication partners. 



New Pull Partner Default Configuration

Specifies default values for configuring new pull partners for this WINS server. In the Start Time box, specify 
when the pull partner default configuration will begin. In the Replication Interval box, specify a number to 
indicate how often data replicas will be exchanged between the partners.



New Push Partner Default Configuration

Specifies default value for configuring new push partners for this WINS server. In the Update Count box, specify
a number to indicate how many registrations and changes can occur locally before a replication trigger is sent by
this server as a push partner.



Address Display

Specifies the method to be used for address information displayed throughout WINS Manager. Click Computer 
Name Only to display only the computer name; IP Address Only to display only the address; Computer 
Name, IP Address to display the computer name first, with the address to the right of the name; or IP 
Address, Computer Name to display the address first, with the computer name to the right of the address.



Server Statistics

Allows you to specify how you want to update the display of statistics in the WINS Manager window. Click Auto 
Refresh to specify whether the statistics in the WINS Manager window are refreshed automatically. In the 
Interval (Secs) box, specify the number of seconds between automatic screen refreshes in the WINS Manager 
window.



Computer Names

Specifies whether computer names will adhere to the LAN Manager naming convention, where computer names 
are limited to 15 characters, as opposed to 16-character NetBIOS names used by other sources. In LAN Manager 
names, the 16th byte is used to indicate whether the device is a workstation, messenger, and so on.
Select the LAN Manager Compatible check box if you want to use this convention. Note that Windows NT 
follows the LAN Manager convention, so this check box should be selected unless your network accepts NetBIOS 
names from other sources.



Miscellaneous

Click Validate Cache Of Known WINS Servers At Startup Time to specify whether the system queries the 
list of servers for available servers each time the system starts or Confirm Deletion of Static Mappings And 
Cached WINS Servers to specify whether a warning message appears each time a static mapping or a cached 
WINS server is deleted.



Validate WINS Server 

This dialog box allows you to specify the IP address when the WINS server cannot be found based on its NetBIOS 
name, or conversely, to specify the NetBIOS name when it cannot be found based on its IP address.



Edit Addresses by Hex 

Use this dialog box to edit IP addresses as hexadecimal values.



Import Static Mappings

Use this dialog box to import entries for static mappings for unique and special group names from any file that 
has the same format as the LMHOSTS file. This dialog box appears when you click Import Mappings in the 
Static Mappings dialog box.
Specify a filename for a static mappings file by typing its name in the box, or click one or more filenames in the 
list, and then click OK to import the file.
Each specified file is read, and a static mapping is created for each computer name and address. If the #DOM 
key word is included for any record, a special group is created (if it is not already present), and the address is 
added to that group.
Note that you can only add a normal group or multihomed names by using the Add Static Mappings dialog 
box. 



Click Help Topics to see a list of Help topics.




